ACID, ACIDized, ACIDplanet.com, ACIDplanet, the ACIDplanet logo, ACID XMC, Artist Integrated, the Artist Integrated logo, Beatmapper, Cinescore, CD Architect, DoStudio, DVD Architect, Jam Trax, Perfect Clarity Audio, Photo Go, Sound Forge, Super Duper Music Looper, Transparent Technology, Vegas, Vision Series, and Visual Creation Studio are the trademarks or registered trademarks of Sony Creative Software Inc. in the United States and other countries.

PlayStation is a registered trademark and PSP is a trademark of Sony Computer Entertainment Inc.

All other trademarks or registered trademarks are the property of their respective owners in the United States and other countries.

Sony Creative Software Inc. may have patents, patent applications, trademarks, copyrights, or other intellectual property rights covering subject matter in this document. Except as expressly provided in any written license agreement from Sony Creative Software Inc., the furnishing of this document does not give you any license to these patents, trademarks, copyrights, or other intellectual property.

Sony Creative Software Inc.
8215 Greenway Blvd.
Suite 400
Middleton, WI 53562
USA

The information contained in this manual is subject to change without notice and does not represent a guarantee or commitment on behalf of Sony Creative Software Inc. in any way. All updates or additional information relating to the contents of this manual will be posted on the Sony Creative Software Inc. Web site, located at http://www.sonycreativesoftware.com. The software is provided to you under the terms of the End User License Agreement and Software Privacy Policy, and must be used and/or copied in accordance therewith. Copying or distributing the software except as expressly described in the End User License Agreement is strictly prohibited. No part of this manual may be reproduced or transmitted in any form or for any purpose without the express written consent of Sony Creative Software Inc.

Copyright © 2014. Sony Creative Software Inc.

Program Copyright © 2014. Sony Creative Software Inc. All rights reserved.
# Table of Contents

Table of Contents .......................................................................................................................... 3

## Introduction ............................................................................................................................... 5

- About DoStudio Encoder ........................................................................................................... 5
- Technical support ....................................................................................................................... 6
- About your rights in DoStudio Encoder software .................................................................... 6
- About your privacy ...................................................................................................................... 6
- Proper use of software ............................................................................................................... 6

## DoStudio Encoder and the Blu-ray Disc Specification ............................................................... 7

- Primary Video Streams for 2D Blu-ray Disc .............................................................................. 7
- Secondary Video Streams for 2D Blu-ray Disc .......................................................................... 7
- MVC Encoding for Blu-ray 3D .................................................................................................. 8

## Preparing Your Video for Import into DoStudio Encoder ....................................................... 11

- Exporting QuickTime Files from Final Cut Pro ....................................................................... 11
- Preparing Your Windows Environment for QuickTime Playback ......................................... 12
- Exporting Chapter Markers from Vegas Pro ............................................................................. 13
- Exporting Chapter Markers from Final Cut Pro ....................................................................... 14

## Using DoStudio Encoder .......................................................................................................... 15

- The DoStudio Encoder Interface ............................................................................................. 15
- Starting a New Project ................................................................................................................ 15
- Adding Source Video Files ....................................................................................................... 16
- Adding Chapter Markers .......................................................................................................... 19
- Encoding Templates .................................................................................................................. 20
- Batch Encoding ........................................................................................................................ 24
- Exporting LPCM Audio from Your QuickTime File ................................................................. 25
- Converting QuickTime Files .................................................................................................... 25

## Troubleshooting ........................................................................................................................ 27

- Understanding the DoStudio Encoder Log Files .................................................................... 27
- Troubleshooting Steps .............................................................................................................. 27

## Index ......................................................................................................................................... 29
Introduction

DoStudio Encoder is a high-quality, easy-to-use solution for encoding MPEG-4 AVC files for Blu-ray Disc™ and MPEG-4 MVC files for Blu-ray 3D™.

DoStudio Encoder is verified for use with the following formats:

- QuickTime files in the following codecs:
  - ProRes 422, ProRes 422 (HQ)
  - DNxHD
  - Uncompressed 10-bit (AJA, Blackmagic)
  - Uncompressed 8-bit (AJA)
  - XDCAM HD
- Uncompressed AVI
- YUV (UYVY colorspace)

About DoStudio Encoder

What DoStudio Encoder does

- Transcodes input files into Blu-ray Disc-compliant MVC files for Blu-ray 3D
- Transcodes input files into Blu-ray Disc-compliant AVC files for Blu-ray Disc
- Displays source QuickTime files and allows you add chapter markers
- Allows you to add multiple source files and batch encode them
- Allows one- and two-pass encoding

What DoStudio Encoder does not do

- Does not convert frame rates and frame sizes. Your source files must have a valid Blu-ray Disc frame size and frame rate. For more information, see "DoStudio Encoder and the Blu-ray Disc Specification" on page 7.
- Does not concatenate multiple source video files into a single elementary stream
- Does not allow segment re-encoding
- Does not include filtering or other image enhancements during the encoding process
Technical support
Please log in to your support account to submit your support requests to the DoStudio team. You can access your support account on the Support tab in the DoStudio Smart Support application or by going to http://scsproservices.custhelp.com.

The DoStudio Smart Support application is your source for managing licenses; requesting support; accessing the DoStudio community forums; and downloading software updates, third-party applications, and legacy applications.

If you are using a trial version of the software or cannot access your support account, you can email your support requests to the Sony Creative Software DoStudio team at DoStudioSupport@am.sony.com.

About your rights in DoStudio Encoder software
DoStudio Encoder software is licensed to you under the terms of the End User License Agreement you entered into with Sony Creative Software Inc.

About your privacy
Sony Creative Software Inc. respects your privacy and is committed to protecting personal information. Your use of the software is governed by the Software Privacy Policy. Please review its contents carefully as its terms and conditions affect your rights with respect to the information that is collected by the software. For your reference, a copy of the Software Privacy Policy is located at http://www.sonycreativesoftware.com/corporate/privacy.

Proper use of software
DoStudio Encoder software is not intended and should not be used for illegal or infringing purposes, such as the illegal copying or sharing of copyrighted materials. Using DoStudio Encoder software for such purposes is, among other things, against United States and international copyright laws and contrary to the terms and conditions of the End User License Agreement. Such activity may be punishable by law and may also subject you to the breach remedies set forth in the End User License Agreement.
DoStudio Encoder and the Blu-ray Disc Specification

This section provides important technical details about valid frame sizes, frame rates, and codecs for Blu-ray Disc™ and Blu-ray 3D™. Most importantly, it describes the valid combinations of these various elements.

Primary Video Streams for 2D Blu-ray Disc

DoStudio Encoder accepts all valid Blu-ray Disc frame sizes and frame rates for primary video on 2D Blu-ray Disc except for the 1440x1080 frame size. This frame size is not widely used in professional production.

The following chart describes the frame sizes and resolutions that are supported by DoStudio Encoder:

<table>
<thead>
<tr>
<th>Frame size (pixels)</th>
<th>Frame rate (Hz)</th>
<th>Progressive/Interlace</th>
<th>Aspect ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920x1080</td>
<td>29.97</td>
<td>Interlace</td>
<td>16:9</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>Interlace</td>
<td></td>
</tr>
<tr>
<td></td>
<td>23.976</td>
<td>Progressive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>24</td>
<td>Progressive</td>
<td></td>
</tr>
<tr>
<td>1280x720</td>
<td>59.94</td>
<td>Progressive</td>
<td>16:9</td>
</tr>
<tr>
<td></td>
<td>50</td>
<td>Progressive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>23.976</td>
<td>Progressive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>24</td>
<td>Progressive</td>
<td></td>
</tr>
<tr>
<td>720x480</td>
<td>29.97</td>
<td>Interlace</td>
<td>4:3 or 16:9</td>
</tr>
<tr>
<td>720x576</td>
<td>25</td>
<td>Interlace</td>
<td>4:3 or 16:9</td>
</tr>
</tbody>
</table>

Secondary Video Streams for 2D Blu-ray Disc

Secondary video streams are used for the picture-in-picture feature of a Blu-ray Disc. The secondary video track runs in sync with the primary video track and can be viewed in a picture-in-picture window. The visibility of the secondary video track can be controlled by the viewer with the remote control or menu option, or the Blu-ray Disc author can program the disc to make the secondary video track visible at specific times.

DoStudio Encoder creates MPEG-4 AVC elementary streams for both primary and secondary video. The Blu-ray Disc specification allows the following combination of codecs for primary and secondary video:
Primary Video Streams | Secondary Video Streams
---|---
MPEG-2 | Allowed | Allowed | Allowed
MPEG-4 AVC | Prohibited | Allowed | Prohibited
VC-1 | Prohibited | Prohibited | Allowed

There are some important bit rate considerations you must know when making a disc with secondary video for picture-in-picture features.

- The Blu-ray Disc specification defines the total video bit rate value of primary video and secondary video streams (including subtitles) must be less than or equal to 40 Mbps. In practice, it is best to keep your overall bit rate under 38 Mbps due to playback inconsistencies among Blu-ray Disc players.
- The maximum video bit rate for secondary video streams must be less than or equal to 7.6 Mbps.

DoStudio Encoder provides templates for primary and secondary video that help you manage the bit rate of your encoded video so that it stays within the legal limits of the Blu-ray Disc specification. For more information, see “Encoding Templates” on page 20.

The Blu-ray Disc specification allows you to create secondary video in all of the standard- and high-definition frame rates and sizes. However, most Blu-ray Disc players cannot playback a secondary video stream that contains high-definition video. Therefore, DoStudio Encoder supports only standard-definition video frame sizes for secondary video streams according to the following table:

<table>
<thead>
<tr>
<th>Frame size (pixels)</th>
<th>Frame rate (Hz)</th>
<th>Progressive/Interlace</th>
<th>Aspect ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>720x480</td>
<td>29.97</td>
<td>Interlace</td>
<td>4:3 or 16:9</td>
</tr>
<tr>
<td>720x576</td>
<td>25</td>
<td>Interlace</td>
<td>4:3 or 16:9</td>
</tr>
</tbody>
</table>

**MVC Encoding for Blu-ray 3D**

**Valid frame resolutions and frame rates for Blu-ray 3D Video**

The Blu-ray Disc specification allows a limited combination of frame resolutions and frame rates for use with Blu-ray 3D. The following are the only valid frame resolutions and frame rates for Blu-ray 3D:

- 1920x1080 @ 23.978 fps progressive
- 1280x720 @ 59.94 fps progressive
- 1280x720 @ 50 fps progressive

**Overview of the MVC format**

MVC stands for Multiview Video Coding. It is an amendment to the H.264/MPEG-4 AVC video compression standard developed with joint efforts by MPEG/VCEG that enables efficient encoding of sequences captured simultaneously from multiple cameras using a single video stream.
In layman’s terms, the MVC format includes a full-frame 2D AVC stream, called the base view, and a secondary offset file called the dependent view. The base view MVC stream is backward compatible with H.264/AVC, which allows standard 2D Blu-ray Disc players and software to decode stereoscopic video streams. They play the base view and simply ignore the additional information contained in the dependent view. The MVC format is highly efficient, and the dependent view only adds about 50 percent extra bit rate to the overall stream.

It is important to note that the base and dependent views do not directly correlate to left- and right-eye streams. While the base view contains the full resolution left eye HD stream (and in theory can be viewed on its own), the dependent view does not contain video information to function as a viewable stream unless paired with the base view. The dependent view contains offset data that relies on the video stream information contained in the base view.

**Source files and the encoding process**

3D encoding requires two HD source files, one for each eye. Each source file must be a full-frame HD stream in one of the three valid resolutions for Blu-ray 3D (see above).

The DoStudio Encoder interface requires you to select the appropriate stream for each eye. You make bit rate selections and start the encoding process. Because MVC encoding is really an extension of AVC encoding for Blu-ray Disc, the encoding process is essentially the same, apart from the need for two input video streams.

The output of the encoding process is a little different. The DoStudio Encoder MVC encoder outputs two files. It outputs the base view as a single file (“my3dfilm_base.mvc”) and the dependent view as a single file (“my3dfilm_dependent.mvc”). You will add both files to the authoring system.

DoStudio Encoder also gives you the option to export a single interleaved MVC file. This file can be played back in ArcSoft TotalMedia Theatre for proofing the quality of the encode prior to authoring your BD3D. There are also mobile and broadcast applications that use the single interleaved MVC file.

**3D sequences**

DoStudio Encoder also provides you with the number of 3D sequences you are using. If you are encoding your footage for replication, set this number to 32. This should be the default value for all new projects. If you know your 3D authoring program can use a specific number, then use that number. DoStudio Authoring does not specify a number so it is best to use 32 if you are using DoStudio Authoring. Contact your authoring tool for more information about what number should be used.

For more information, see “Adding 3D primary video files” on page 18.
Preparing Your Video for Import into DoStudio Encoder

In order to successfully encode your video for a Blu-ray Disc™, your source video must be exported as a QuickTime uncompressed AVI or YUV file that is in one of the supported frame sizes and frame rates described in the previous section. DoStudio Encoder will not convert an invalid frame size or frame rate during the encoding process.

If you are using QuickTime, your file must be exported in one of the following codecs for input into DoStudio Encoder:

- AJA 8-bit/10-bit uncompressed
- Blackmagic 10-bit uncompressed
- Apple ProRes 422/Apple ProRes 422 (HQ)
- XDCAM HD
- DNxHD

Exporting QuickTime Files from Final Cut Pro

The following sections describe the process for exporting your source video files from Final Cut Pro. They are listed by the codec type.

8-bit/10-bit uncompressed

The uncompressed formats are native to your Final Cut setup depending on which I/O hardware you have installed. If you have a KONA card or other AJA I/O device, you will see the AJA 8-bit and 10-bit uncompressed settings in your Easy Setup. Likewise, you will find Blackmagic versions of these formats if your system has hardware from Blackmagic Design.

In order to export a file in these formats, it is recommended that you set up your sequence in the 8-bit or 10-bit format of your choosing and edit your video in this sequence. If you have edited your sequence using a different setting, simply copy and paste the elements of the sequence into the new 8-bit or 10-bit uncompressed sequence. Make sure that the video is still appearing as it should (check especially for any issue with the scaling of the image) and render the sequence if necessary.

To export the file, select Export Movie from the File menu and select Current Settings (these will be the uncompressed settings you set up in the Easy Setup). Choose a file name and location for your exported file and click OK. The time it takes to export the file will vary depending on the size of the file.
Apple ProRes 422/ProRes 422 (HQ)

The ProRes codec is native to Final Cut Pro and is supported by the QuickTime player on Mac OS X and Windows XP/Vista.

As with the uncompressed formats, it is recommended that you set up your sequence in the ProRes format of your choice and edit your video in that sequence. To export the file, select Export Movie from the File menu and select Current Settings (these will be the ProRes settings you set up in the Easy Setup). Choose a file name and location for your exported file and click OK.

XDCAM HD

XDCAM HD is a codec from Sony that is installed with Final Cut Pro. It is a variable bit rate video format that is used by Sony's XDCAM line of professional cameras and VTRs. The current generation XDCAM HD uses the 4:2:2 profile of the MPEG-2 codec, which has double the chroma resolution of the previous generations. To accommodate the chroma detail, the maximum video bit rate has been increased to 50 Mbps.

As with the uncompressed and ProRes formats, it is recommended that you set up your sequence in the XDCAM HD format and edit your video in that sequence. To export the file, select Export Movie from the File menu and select Current Settings (these will be the XDCAM settings you set up in the Easy Setup). Choose a file name and location for your exported file and click OK.

DNxHD

DNxHD is a codec provided by Avid Technologies that includes a high quality/small file size algorithm that is similar in quality and performance to Apple ProRes. This codec is native to Avid editing applications but is not native to Final Cut Pro. However, Avid provides the codec for installation on OSX free of charge. The codec can be downloaded here: http://avidtechnology.custhelp.com/cgi-bin/avidtechnology.cfg/php/enduser/std_adp.php?p_faqid=71356

Because DNxHD is not native to Final Cut Pro, you must export your files using QuickTime Conversion in order to export a file using the DNxHD codec. It is recommended that you set up your sequence in the 10-bit uncompressed format, the Apple ProRes 422 format, or the ProRes 422 (HQ) format and edit your video in that sequence. When your video is ready for exporting, select Export Movie > Using QuickTime Conversion from the File menu. Select DNxHD from the format selection list.

Preparing Your Windows Environment for QuickTime Playback

In order to import QuickTime files from Final Cut Pro into DoStudio Encoder, you must be able to play the QuickTime files on your Windows workstation using QuickTime. Depending on which codec you used, you may need to download and install the codec prior to attempting to import the QuickTime file into the DoStudio Encoder.

<table>
<thead>
<tr>
<th>Codec</th>
<th>Installation Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>AJA 8-bit/10-bit uncompressed</td>
<td><a href="http://www.aja.com/products/software/">http://www.aja.com/products/software/</a></td>
</tr>
<tr>
<td>Blackmagic 10-bit uncompressed</td>
<td><a href="http://www.aja.com/products/software/">http://www.aja.com/products/software/</a></td>
</tr>
</tbody>
</table>
**Codec** | **Installation Instructions**
--- | ---
Apple ProRes 422/ProRes 422 (HQ) | Included with your QuickTime installation.
XDCAM HD | [www.calibratedsoftware.com](http://www.calibratedsoftware.com) - $79 decoder for Windows

Remember, if you can’t play your source QuickTime file in the QuickTime player on your Windows workstation, it will not import successfully into DoStudio Encoder. It is very important that you set up your Windows environment to play back the QuickTime source files before attempting to encode your video.

**Exporting Chapter Markers from Vegas Pro**

You can mark your chapter points in your Sony Vegas Pro timeline and export them to a CSV, TXT, or XML file using the Export Chapters script.

**Creating chapter markers in Vegas Pro**

1. Position the cursor where you want to add a marker.
2. From the Insert menu, choose Marker. A marker is added at the cursor position and an edit box is displayed.
3. Type a name for the marker in the edit box and press Enter.
   - You can also insert markers by pressing the M key.

**Exporting chapter markers from Vegas Pro**

Use the Export Chapters script in Vegas Pro 11 and later to export your chapter markers to a CSV, TXT, or XML file that can be read by DoStudio Encoder.

1. From the Tools menu, choose Scripting, and then choose Export Chapters.
   - The Export Chapter Information dialog box appears.
2. Select the drive and folder where you want to save the file.
3. Type a name in the File name box.
4. Select the type of file you want to export in the Save as type list.
5. Click the Save button.
For more information about importing chapter markers from Vegas Pro, see “Adding Chapter Markers” on page 19.

Exporting Chapter Markers from Final Cut Pro

You can mark your chapter points in your Final Cut Pro timeline and export them using Apple’s Final Cut Pro XML.

Creating chapter markers in Final Cut Pro

Place the playhead in your timeline at the location where you would like to create a chapter. Press M to add a marker. Press M again to edit the marker’s information.

Click the Done button. Do this wherever you want to create a chapter.

Exporting chapter markers from Final Cut Pro

DoStudio Encoder uses the XML file that you can export from Final Cut Pro to import your chapter markers. To export the XML file, select the sequence that contains your video and your chapter markers, then select File > Export XML.

For more information about importing chapter markers from Final Cut Pro, see “Adding Chapter Markers” on page 19.
Using DoStudio Encoder

This section describes the basic operation of DoStudio Encoder.

The DoStudio Encoder Interface

DoStudio Encoder is project based. To add source video for encoding, you create encoding segments, apply a template to your segments, then submit the entire project to the batch encoder.

DoStudio Encoder allows you to play back your source QuickTime file in the Control Panel and mark chapter points if desired.

Templates are applied using a drag-and-drop operation. Once applied, you can adjust the parameters for each encoding segment.

By default, your project includes one encoding segment with nodes for primary and secondary video. If your encoding project includes multiple source videos, you will add additional encoding segments to your tree and select source videos for each title.

Starting a New Project

To begin, create a new project or open an existing project. Project files use the extension .dsEp. You can save your project file in any convenient location on your workstation except for the desktop.
Setting the Output Folder and Notification settings

When you start a new project, by default you see the project output folder and notification settings in the Control Panel. (You can click the project name at the top of the Titles list to display these settings at any time.)

Project Settings

You can set the output folder to any local or network-accessible folder. This is where your encoded video files will be created.

Notification Settings

DoStudio Encoder offers two methods of setting up status notifications during an encode: email and Twitter. Enter your account settings for either or both of these notification options in the Control Panel. Your account settings will be saved on your workstation so they will appear when you start a new project. The settings are not saved in your project file so you can share your encoding project without sharing your private email and Twitter settings.

You can setup which notifications to receive by using the combo boxes. You can choose to receive a notification when an error occurs, when the encoding starts and ends and you can receive a status update at a regular interval.

Adding Source Video Files

Each encoding segment in the Titles window contains a node for primary audio/video and secondary audio/video. You will add your source video file to the node that corresponds to the type of video you are encoding. In most cases your video will be a primary video stream. You will only use the secondary video stream if you are planning to use the picture-in-picture capabilities of standard (2D) Blu-ray Disc.

For 3D encoding, you will always create a primary video stream. There is no secondary (PiP) stream in 3D.

You can add 2D and 3D segments to the same encoding project and batch encode them at the same time. It is not necessary to split your 2D and 3D encoding into separate projects.
Adding 2D primary video files

1. Right-click the Primary Audio/Video node, and then click Add 2D Primary Video.

2. You are prompted to select a source video stream. Navigate to your source file and select it.

   You will now see your 2D source video file listed in the Titles window under the Primary Audio/Video node.

   The Highest Quality template is applied to your segment by default.

   The check box indicates that you would like to encode this video when you submit the batch for encoding. You can clear the check box to exclude the file from the batch.

   The Control Panel displays your source video’s properties and a playback window to view your source video and set chapter marks.

   If you have selected a source video file that is not a Blu-ray Disc compliant frame size or resolution you will be notified in a pop-up window that your video is not acceptable for input into DoStudio Encoder. For more information about valid frame sizes and frame rates for Blu-ray Disc, see “Primary Video Streams for 2D Blu-ray Disc” on page 7.
Adding 2D secondary video files

The process for adding a source video file for secondary video is the same as the process for primary video. The only difference is that DoStudio Encoder supports only standard-definition video files for secondary video. For more information about valid secondary video formats, see "Secondary Video Streams for 2D Blu-ray Disc" on page 7.

Adding 3D primary video files

1. Right-click the Primary Audio/Video node, and then click Add 3D Primary Video.

2. You are prompted to select the left eye source video stream first. Navigate to your source file for the left eye and select it.

3. Next, you are prompted to select the source video stream for the right eye. You will now see your 3D source video file listed in the Titles tree under the Primary Audio/Video node.

You will only see the left eye stream listed in the tree.

The Highest Quality template is applied to your segment by default.

The check box indicates that you would like to encode this video when you submit the batch for encoding. You can clear the check box to exclude the file from the batch.

The Control Panel displays your source video's properties and a playback window to view your source video and set chapter marks.

You can select which source file to view using the Left/Right selection box found in the Control Panel.
Adding segments

To add additional source video files to your project, you need to add additional encoding segments to your Titles tree.

To do this, right-click the name of your project at the top of the Titles window, and then click Add Segment. You can add as many segments as your project requires. Keep in mind that you can add both 2D and 3D segments to the same encoding project.

![Adding segments](image)

Adding Chapter Markers

Adding chapter markers is useful because DoStudio Encoder will create an I-frame at the chapter markers which will guarantee frame accuracy for the chapter when you author your disc in DoStudio Authoring. You can add chapter markers to your video in two ways.

Add chapters manually by entering timecode

1. Right-click the Chapters list, and then click Add A Chapter.

![Add A Chapter](image)

2. Select the new chapter in the list.
3. Type a timecode value for the chapter in the Timecode box.

Importing chapters from a Sony Vegas Pro file

You can import chapter markers created in a Sony Vegas Pro project into DoStudio Encoder. For more information about exporting your chapter markers from Vegas Pro, see "Exporting Chapter Markers from Vegas Pro" on page 13.

1. Right-click the Chapters list, and then click Import Chapters From Vegas File.
2. Browse to your CSV, TXT, or XML file from Vegas Pro and click Open.

The chapter markers exported from Vegas Pro appear in the Chapters list.
Importing chapters from a Final Cut Pro XML file

You can import chapter markers created in a Final Cut Pro project into DoStudio Encoder. For more information about exporting your chapter markers from Final Cut Pro, see “Exporting Chapter Markers from Final Cut Pro” on page 14.

1. Right-click the Chapters list, and then click Import Chapters From Final Cut Pro XML.

2. Browse to your XML file from Final Cut Pro and click Open.

   The chapter markers exported from Final Cut Pro appear in the Chapters list.

Importing chapters from a text file

You can import chapter markers from a simple text file. The text file should be formatted with one chapter entry per line. No header information is required. DoStudio Encoder will determine the frame rate from the video segment setting. The chapters should be formatted in non-drop format (HH:MM:SS:FF) starting at 00:00:00:00.

Your text file should look like this:

00:00:00:00
00:03:10:12
00:14:03:06
00:20:06:00

1. Right-click the Chapters list, and then click Import Chapters From Text File.

2. Browse to your text file and click Open.

   The chapter markers from the text file appear in the Chapters list.

Encoding Templates

How your source video is encoded is determined by several encoding settings that are contained in templates. You must apply a template to your source video in order to encode it.

The process for applying a template is the same for 2D AVC encoding and 3D MVC encoding.

For 3D MVC encoding, you will use only the primary video templates. There is no secondary video track on a 3D Blu-ray Disc.
Primary Video Templates

Primary video templates define your encoding parameters for primary video. DoStudio Encoder provides the following primary video templates:

- **Highest Quality** – 90 minutes on a BD25, no secondary video and no high-bandwidth audio. (VBR: Target: 35 Mbps, Max: 38 Mbps)
- **Feature Video** – 120 minutes on a BD25, no secondary video and space for LPCM or other high-bandwidth audio (VBR: Target: 25 Mbps, Max: 35 Mbps)
- **Bonus Video** – Medium quality video: 180 minutes on a BD25 (VBR: Target 18 Mbps, Max: 30 Mbps)

Secondary Video Templates

Secondary video templates define your encoding parameters for secondary video. The Blu-ray Disc specification limits the bit rate of secondary video to 7.6 Mbps, so your secondary video template will not allow you to exceed 7.6 Mbps.

DoStudio Encoder provides the following secondary video templates:

- **Single PiP track** – no secondary audio, (CBR: Target: 7.0 Mbps)
- **Single PiP track** – secondary audio (CBR: Target: 6 Mbps)
- **2 PiP tracks** – no secondary audio (CBR: Target: 3.6 Mbps)
- **2 PiP tracks** – secondary audio (CBR: Target: 3 Mbps)

Apply encoding templates to video files

To apply an encoding template, simply drag the desired template from the Primary Video Templates window or Secondary Video Templates window to the your source video file in the Titles list.

You will see the template listed in the Titles list underneath the source file to which it is applied. Select the template to display its properties in the Control Panel.

You can edit the encoding parameters for a specific clip after you have applied the template.
## Encoding Parameters

![Control Panel Image]

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The name of the encoding template.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>A description of the encoding template.</td>
</tr>
<tr>
<td><strong>Encoding Mode</strong></td>
<td>You can select either Constant Bit Rate (CBR) or Variable Bit Rate (VBR).</td>
</tr>
<tr>
<td><strong>Number Of Passes</strong></td>
<td>You can select one or two passes. In two-pass mode, the encoder performs an analysis pass, and then encodes your video in a second pass.</td>
</tr>
<tr>
<td></td>
<td>In single pass mode, the analysis is performed concurrently with the encoding process.</td>
</tr>
<tr>
<td><strong>Target Bit Rate</strong></td>
<td>For CBR encodes, use the slider to set a value for your desired bit rate. Your video will be encoded at this bit rate throughout the entire clip.</td>
</tr>
<tr>
<td></td>
<td>For VBR, use the slider to set a value for the average bit rate. You will set the maximum (peak) bit rate for your VBR encode in the <strong>Max Bit Rate</strong> box.</td>
</tr>
<tr>
<td><strong>Max Bit Rate</strong></td>
<td>For VBR encodes, set the maximum bit rate for your encode in the <strong>Max Bit Rate</strong> box. Keep in mind that the maximum recommended bit rate for Blu-ray Disc video is 38 Mbps.</td>
</tr>
</tbody>
</table>

### Bit rate considerations for 2D Blu-ray Disc

The maximum video bit rate allowed for Blu-ray Disc projects is 40 Mbps, but in practice it is best not to exceed 38 Mbps due to playback performance issues on some Blu-ray Disc players when your video approaches the 40 Mbps rate. DoStudio Encoder limits you to 38 Mbps in order to maximize playback compatibility.

In practice, you should be conservative when determining how high of a bit rate to allow for. Trying to squeeze out the highest possible bit rate for your project can lead to player compatibility and disc space issues. If your project calls for multiple audio tracks, or if you plan to use LPCM audio, DTS-HD Master Audio, or Dolby TrueHD, you will need to limit the video data rate so as not to exceed the overall bit rate.
allowed by the Blu-ray Disc specification. A general recommendation is to not exceed 43 Mbps for your combined video and audio bit rate.

**Bit rate considerations for 3D Blu-ray Discs**

When you encode a 3D MVC file, you select the target and max bit rate for the base view stream only. The bit rate and corresponding file size of the dependent view file is relative to the bit rate of the base view and cannot be manually controlled. The dependent view is not actually a complete video stream. Rather it contains offset information and video data that can only be displayed when combined with the base view. The overall bit rate of the combined MVC files is approximately 50 percent higher than the base view file by itself.

**Custom encoding templates**

To create your own custom encoding templates, you can duplicate an existing template and edit its encoding parameters or you can create a template from scratch. You can also export and import encoding templates to share with other DoStudio Encoder users.

**Creating encoding templates**

1. Select the Primary Video Templates window or Secondary Video Templates window, depending on which kind of encoding template you want to create.

2. Right-click the window, and then click **Add Template**.

3. Select the new template to display and edit its properties in the Control Panel.

**Duplicating encoding templates**

1. Select the Primary Video Templates window or Secondary Video Templates window.

2. Right-click the template you want to duplicate, and then click **Duplicate Template**.

   A copy of the template is created with the word “copy” appended to the template name. Select the duplicate template to display and edit its properties in the Control Panel.

**Exporting encoding templates**

You can export your encoding templates to a .dsEpTemplates file that can be shared with other DoStudio Encoder users.

1. In the Primary Video Templates window or Secondary Video Templates window, select the templates you want to export.

2. Right-click one of the templates, and then click **Export Template(s)**.

3. Select the drive and folder where you want to save the file.

4. Type a name in the **File name** box.

5. Click the **Save** button.
Importing encoding templates

1. Select the Primary Video Templates window or Secondary Video Templates window.
2. Right-click the window, and then click Import Template(s).
3. Browse to the .dsEpTemplates file you want to import and click Open.

The templates are added to your DoStudio Encoder project.

Batch Encoding

When you are ready to encode your video, click the Encode button on the toolbar. This will open the batch encode window and submit your project to the batch.

Your project will begin the encoding process immediately. All of the video streams in your project will appear in the Batch Encoding window. A progress bar indicates the encoding status of each video stream.

You can stop the encoding process by clicking the red Stop Encoding button at the bottom of the window. You can stop encoding one stream while continuing to encode the others in your batch by clearing the Encoding The Stream check box for the stream.

Once you have stopped an encode, you need to resubmit the project to the batch to start the process again.

While your video is encoding, a real-time log of the encoder’s activity is displayed in the Encoding Status window. You can monitor the progress of your encoding job and view error messages in this window.

You can select and copy the text in the Encoding Status window by right-clicking and using the Select All and Copy commands.
Batch encoding multiple projects simultaneously

To submit several projects to the batch simultaneously, open the Batch Encoding window by selecting it from the **Window** menu.

Right-click the Projects list, and then click **Add Project** to add a project to the batch. You can add multiple encoding projects to the batch list.

Click the green **Start Encoding** button to submit the batch and start the encoding process. You will see progress bars for each of the source videos.

Exporting LPCM Audio from Your QuickTime File

If your QuickTime file has embedded audio, you can export the audio to an uncompressed LPCM wave file. This LPCM file can be imported into DoStudio Authoring, or it can be imported into another audio application to transcode it into a Blu-ray compliant Dolby or DTS stream.

To export the LPCM wav file simply click the **Export Wav** button in the Control Panel when you select your video stream. In the Export Wav File dialog, choose the folder where you would like to save the file and click **Save**.

Converting QuickTime Files

DoStudio Encoder includes a QuickTime Converter that allows you to transcode your primary or secondary audio/video streams to other QuickTime formats such as .m4v for iPhone.

1. Right-click the source file for your primary or secondary audio/video, and then click **Convert QuickTime File**.
2. Choose the destination folder for your converted QuickTime file and what type of export you would like to perform. All of the standard QuickTime conversion formats are supported.
Troubleshooting

The following guide will help you understand how 3D MVC files are encoded and how to understand the errors if you run into issues.

Understanding the DoStudio Encoder Log Files

Setting up your output folder will automatically create a logs folder under the output folder. Inside this folder are two log files per AVC/MVC file to encode. The two log files are:

1. sourcefilename_ServerLog.log
2. sourcefilename_DSWLog.log

The sourcefilename_ServerLog file contains the name of your source file followed by _ServerLog.log. This log file contains all the core information about the encoded file. This should be the first file to review if something goes wrong.

The sourcefilename_DSWLog.log file contains the name of your source file followed by _DSWLog.log. This log file contains information that will be used to make sure the communication between the DoStudio Encoder server and the DoStudio Encoder user interface are OK.

The System.log file

The System.log file reviews the QuickTime installation and other details about your system that the encoder uses as resources. This file is created once per batch encode.

The DoStudio Encoder log file

The DoStudio Encoder log file is used only by Sony Creative Software and is found in C:\Users\username\Documents\Sony\DSE\log.txt.

Troubleshooting Steps

If the encode fails instantly...

1. Make sure you can play the video using Apple's QuickTime player.

2. Make sure the source files are in one of the acceptable sizes and frame rates for Blu-ray Disc projects. For more information, see "DoStudio Encoder and the Blu-ray Disc Specification" on page 7.

3. Send all log files to the Sony Creative Software DoStudio team. For more information, see "Understanding the DoStudio Encoder Log Files" on page 27 and "Technical support" on page 6.
If the encode fails after more than 1 percent is completed...

1. Make sure there is enough disc space.
2. Make sure there isn’t any antivirus software that will be scanning when the encoder is writing the encoded files.
3. Send all log files to the Sony Creative Software DoStudio team. For more information, see "Understanding the DoStudio Encoder Log Files" on page 27 and "Technical support" on page 6.

The first encode works but the second one fails...

2. Open DoStudio Encoder and then try to encode the second stream.
3. If the encode continues to fail, send all log files to the Sony Creative Software DoStudio team. For more information, see "Understanding the DoStudio Encoder Log Files" on page 27 and "Technical support" on page 6.

The video does not look OK...

Send all log files to the Sony Creative Software DoStudio team. Indicate the specific visual issue you are seeing. For more information, see "Understanding the DoStudio Encoder Log Files" on page 27 and "Technical support" on page 6.

Clicking Batch Encode does nothing...

1. Open the Batch Encoding window if not already open then try again.
2. Send all log files to the Sony Creative Software DoStudio team. For more information, see "Understanding the DoStudio Encoder Log Files" on page 27 and "Technical support" on page 6.
Index

2
2D primary video 16
2D secondary video 16

3
3D primary video 16
3D sequences 8

B
batch encoding 24
Blu-ray Disc specification 7

C
chapters
creating in DoStudio encoder 19
creating in Final Cut Pro 14
creating in Vegas Pro 13
exporting from Final Cut Pro 14
exporting from Vegas Pro 13
importing from Final Cut Pro 19
importing from text file 19
importing from Vegas Pro 19
converting QuickTime files 25
creating
encoding templates 20
projects 15
custom encoding templates 20

D
.dsEp files 15
duplicating encoding templates 20

E
email notification settings 15
encoding templates 20
exporting
chapters from Final Cut Pro 14
chapters from Vegas Pro 13
encoding templates 20

LPCM audio 25
QuickTime files from Final Cut Pro 11

F
Final Cut Pro
chapter markers 14, 19
exporting QuickTime files 11

I
importing
chapter markers 19
encoding templates 20

L
log files 27
LPCM audio 25

M
MVC 8

P
picture-in-picture 7, 16
primary video streams 7
primary video templates 20
projects, creating 15

Q
QuickTime files
converting 25
exporting from Final Cut Pro 11
playing back in Windows 12

S
secondary video streams 7
secondary video templates 20
segments 16
T
- technical support 6
- troubleshooting 27
- Twitter notification settings 15

V
- Vegas Pro chapter markers 13, 19